
INFORMATION TECHNOLOGY                       
POSITION QUESTIONNAIRE FORM 

Employee Instructions 

Please complete this Information Technology Position Questionnaire form. This questionnaire will be used to assist 
the human resources department in determining the proper allocation of your position.   

Submittal Requirements: 

This form may be completed manually or electronically. Please discuss your options with your personnel officer. You 
may include exhibits to explain your responses or provide additional information. Please note the appropriate 
question you are referring to when providing exhibits. Make sure the Personnel Officer has a copy of all your exhibits.  
Keep a copy of your questionnaire and all exhibits. 

 

Manual Submittal: Please complete the form and give it to your first- and second-level supervisor for 
comments.  All parties will be required to verify and sign the appropriate sections of the 
form. Submit to your personnel officer.  The questionnaire may be forwarded to the 
Director of the Department of Personnel (DOP) in the event of an allocation appeal. 

Electronic Submittal: Please complete the form electronically and E-mail it to your first- and second-level 
supervisor for comments.  All parties will be required to verify and sign the appropriate 
sections of the form. E-mail the completed form to  your personnel officer. The 
questionnaire may be forwarded to the Director of the Department of Personnel (DOP) in 
the event of an allocation appeal.  

 
To Use Electronic Position Questionnaire Form: 
 
Save the form as a Microsoft Word document (version 6.0 or higher).   
 
This questionnaire form may not be compatible with other software (including WordPerfect and Microsoft Works) and 
therefore may not be accepted if saved as such.  
 
Navigation: 
 
1. To move from field to field, use the “Tab” key or Click on the appropriate gray field with mouse pointer. 
2. To mark a check box, i.e., , click on the box with mouse pointer.  Clicking a second time will uncheck the box.  
 
Formatting: 
 
This form uses the "Protect Document" function in the Tools menu. This setting provides the ability to Tab from field 
to field and complete the form quickly. Use this function to complete the form. The “Unprotect Document” function 
disables the ability to Tab from field to field, and allows formatting for adjusting fields prior to printing.  You should 
complete all requested information prior to using the “Unprotect Document” function. 
 
1. Complete the form with the Protect function enabled.  (This is the default setting for the document) 
2. To adjust formatting in Word, click on the Tools menu and then “Unprotect Document”.  This will enable you to 

enter returns and/or spaces where necessary to adjust page breaks and other formatting. 
3. Use the mouse to navigate within the unprotected document. 
4. DO NOT use or reset the “Protect Document” function after you’ve filled in the information on the form 

and adjusted formatting.  Doing so will erase all completed information, leaving you with a blank Questionnaire 
form. 

 
Printing: 
 
1. To print, click on the “File” menu at the top of the screen, choose “Print”, for either the whole document or 

selected pages. 
2. If you receive an error message saying that some of the document lies outside of the printable area, Word will 

automatically make the necessary adjustments if you click “OK” or “Fix”. 
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INFORMATION TECHNOLOGY  
POSITION QUESTIONNAIRE FORM 

 
 
 

Employee Name (Last, First, Initial) 

      

Present Classification Title 
 
      

Working Title (if different) 
 
      

Institution  

      

Institution Mailing Address 

      

E-mail Address (optional) 

      

Division, Department, or Unit 

      

Building 

      

Room No. 

      

Work Phone 

      

Duration of Employment         
With Institution With Present Duties 

Years Months Years Months 

Work Week (e.g. M-F)   
 
      

Hours: (e.g. 40) 

      

Months/Yr. (e.g. 
12) 

      

Shift (e.g. day) 

      

 
      

 

   
                  

Supervisor Name (Last, First, Initial) Title E-mail Address 

      

Work Phone  

                  

 

 

 

PART I - Major Job Duties 

INSTRUCTIONS 

Describe your major job duties (those which take at least 5% or 2 hours a week to perform) following the 
example given below.  Try to group similar tasks into major duties.  Be sure to give the approximate 
percentage of time per month you perform each major duty. 

If you have completed a position description form for your local position review, you may attach a copy 
here instead of completing this page of the form.  If not, describe your entire job - include your routine and 
occasional duties.   

Generally, the duties you describe should encompass the previous six- to twelve-month period, including 
projects that may have been completed in that time. 
 

IMPORTANT - Read this Position Questionnaire carefully and provide all of the requested information.  
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INFORMATION TECHNOLOGY  
POSITION QUESTIONNAIRE FORM 

 
Question 1. Fill in the following Table: 

MAJOR DUTY DESCRIPTION OF DUTIES 

List the major duties in your regular work 
assignment.  In the small box, show the 
percentage of time you spend on the duty 
each month. 

Describe the things you do to complete each of these duties. 

 

40% 

Example:  
 
Provide basic IT technical support 
to computer system users  

 
 
• Provide correct log-on procedures 
• Change user passwords; install new keyboards 

 %       

 

 

      

 %             

 %             

 %             

 %       

 

 

 

      

 %       
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INFORMATION TECHNOLOGY  
POSITION QUESTIONNAIRE FORM 

 
Question 2: How do you receive your work assignments? 

INSTRUCTIONS:  Work assignments can come from co-workers, supervisor, lead workers, users, or 
others.  In what form are your work assignments given to you?  Work assignments can be spoken, 
written, given by your position description, or come as a result of your own initiative or idea. 
 

Title  
 

Method Assignment 

Example: 
- Supervisor 
- Clients 

 
- Verbally 
- Work Ticket 

 
- Assigns work in meetings 
- E-mails work ticket to fix PC. 

 
      
 

 
      
 

 
      

 
      
 

 
      

 
      

 
      
 

 
      

 
      

  
      

 
            
 
 
      

 
      

 
      
 

 
      

 
      

 
      

 
 

Question 3: When you have a question about how to do your work, who do you ask?   

 
Title Type of Question 

 
Example: 
-Supervisor 
 

 
-Approval to purchase equipment. 
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INFORMATION TECHNOLOGY  
POSITION QUESTIONNAIRE FORM 

 
Question 4: Describe your use of laws, rules, policies, procedures, manuals, or other guidelines to do 

your job.                   

 
Type  Use 

Example: 
- Manual 

 
- Follow Manual to load software onto client's PC.  

      

 

      

      

 

      

      

 

      

      

 

      

      

 

      

  

Question 5:  Do you use advanced hardware and software diagnostic tools such as network analyzing 
equipment and operating system diagnostics to identify and either resolve or refer 
problems to other staff for analysis?        YES       NO If yes, provide examples: 

 
Tool             Use 
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INFORMATION TECHNOLOGY  
POSITION QUESTIONNAIRE FORM 

 
 

Question 6.  If you had to train a qualified person to do your job, how long would it take? 
 

Time:        
 
Explain:       
 
 
 
 
 
 
 

 
 
Question 7. Describe how your work or progress is checked by your supervisor and how often. 
 
How Work or Progress is Checked   
 
Example: 
- My Supervisor only reviews my work if there is a problem. 
- My Supervisor checks my work after each step of the repair  

Frequency 
 
 
- Occasionally 
- Daily 

            

            

            

            

            
 

 
Question 8. Does your job require you to interact with people?  If so, complete the following: 
 

Why Contacted? How Often Contacted: Who 
Contacted? 

Example: 
- Clients 
- Vendors 

 
- Resolve Problems on their PC's. 
- Coordinate upgrades to software 

 
- Daily 
- Monthly 
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INFORMATION TECHNOLOGY  
POSITION QUESTIONNAIRE FORM 

 
 
Question 9. From the following list, check the tasks you perform on a regular basis. 
 
1.  Providing correct log-on procedures, equipment maintenance procedures, operation and 

system usage procedures. 
2.  Changing user passwords. 
3.  Maintaining simple inventories of computer and/or voice equipment and diagrams. 
4.  Re-imaging systems. 
5.  Replicating software images. 
6.  Installing software. 
7.  Upgrading memory or installing components. 
8.  Coding, testing and implementing components of programs based on specifications. 
9.  Assisting with the upgrade/maintenance of smaller components of application projects or 

existing applications. 
10.  Assisting in testing and evaluating hardware/software, or telecommunication products. 
11.  Assisting in identifying customer problems on multiple platforms/computers and 

suggesting remedies. 

12.  Conducting routine debugging using pre-determined methods to resolve low-risk 
problems. 

13.  Isolating application problems and assisting with resolution. 
14.  Isolating system problems and coordinating resolution. 
15.  Performing basic tests on hardware/software and making simple repairs using pre- 

determined methods. 
16.  Consulting with customers to identify and analyze technology needs and problems. 
17.  Analyzing problems for parts of applications and solving problems with some assistance. 
18.  Supporting and enhancing existing applications in compliance with specifications and 

standards. 
19.  Processing equipment and service orders. 
20.  Coordinating installations, moves, and changes. 
21.  Responding to and resolving trouble reports from users. 
22.  Writing specifications and developing reports. 
23.  Developing and conducting application, software and/or system operation training for 

users. 
24.  Serving as part of a problem solving team addressing complex issues. 
25.  Acting as project leader for projects.   
26.  Conducting needs assessments. 
27.  Evaluating products and consulting with customers to analyze technology needs and 

problems. 
28.  Creating installation plans. 
29.  Independently installing and configuring hardware/software. 
30.  Working with vendors to resolve problems. 
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INFORMATION TECHNOLOGY  
POSITION QUESTIONNAIRE FORM 

 
31.  Developing specifications and codes for components of large applications. 
32.  Supporting, maintaining and enhancing existing applications.  
33.  Analyzing and correcting network malfunctions. 
34.  Conducting capacity planning and making recommendations. 
35.  Designing multiple-server systems. 
36.  Designing specialized interfaces. 
37.  Designing and providing instructional technology support. 
38.  Managing multi-server systems. 
39.  Developing and implementing quality assurance testing and performance monitoring. 
40.  Acting as a liaison on the development of client/server applications. 
41.  Representing institution-wide computing and/or telecommunication standards and 

philosophy at meetings. 
42.  Developing security policies and standards. 
43.  Facilitating application interfaces and application integration. 
44.  Assisting others in de-bugging problems with vendor products. 
45.  Researching environment issues, platforms, software and hardware requirements. 
46.  Performing data analysis. 
47.  Developing and maintaining logical data models. 
48.  Designing large-scale or enterprise systems crossing multiple networks, platforms or 

telecommunication environments. 
49.  Developing project plans. 
50.  Directing large-scale, enterprise, or mission-critical projects.  
51.  Identifying and resolving operational problems for systems. 
52.  Conducting capacity planning to determine institution-wide needs and making 

recommendations. 
53.  Developing comprehensive instructional technology support strategies. 
54.  Writing feasibility studies and decision packages for high visibility/impact initiatives. 
55.  Analyzing and resolving very complex problems such as multiple product problems or 

major conflicts caused by a new software version. 
56.  Developing and implementing technical policies. 
57.  Developing requests for proposals, feasibility studies and decision packages for high 

visibility/impact projects. 
58.  Presenting alternatives and recommendations to executives. 
59.  Reviewing project data models for compliance with institutional model. 
60.  Developing training plans and training staff in data modeling, data-modeling case tools 

data repository, and data dictionary. 
61.  Consulting with information technology staff regarding business rules, data integrity, data 

location and use. 
62.  Supporting, maintaining, and enhancing database management systems. 
63.  Developing and implementing on-site backup and recovery procedures and schedules. 
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64.  Leading others. (Please list names and titles of those you lead, i.e. regularly assign, 

instruct, and check the work of others.) 
 

Name  Title 
            
            
            

            

 
65.  Supervising lower-level staff (Please list names and titles of those you supervise, i.e. 

with delegated authority, interview and recommend selection of applicants, train new 
employees, assign and schedule work, act upon leave requests, conduct annual 
performance evaluations and recommend disciplinary action.) 
 
Name  Title 
      
 

      

      
 

      

                   

            

            

 
Question 10. Using the selections you made in Question 9 as a guide, pick your highest-level 

tasks and list them in the left column below. Provide examples of the most 
difficult work associated with those tasks in the right column.  

 
Item # Highest-level  Task(s) 

 
Example(s) of Most Difficult Work 

Example: 
-53  

 
-Developing Project Plans 

 
- Coordinating installation schedule across departments. 
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INFORMATION TECHNOLOGY  
POSITION QUESTIONNAIRE FORM 

 
 
Question11. Is your position responsible for planning?      Yes   No (Go to 13) 
 

a. If you answer yes, please complete the remainder of this question.  Indicate by marking 
the appropriate boxes or filling in the applicable blanks if the statements below apply to 
your position. 

 
Statement Yes No 

a. I plan only for my position.   

b. I plan for my position and _____ other positions.   
 

b. List the other positions by title: 
 

Position Title 

            

            

            

            

 
c. I plan for an entire organization:   (Describe:            ) 

 
(1) number of employees in the organization: 

  (a)  faculty:        
  (b)  administrators:        
  (c) classified employees:        
 (2) number of clients served:        

 (3) amount of annual budget:  $       

d. My plans cover a period of: (check) 
   one week   

  one month  

   one fiscal year   

   a biennium   
 

e. My planning includes forecasts for the following: 
 (1)  People (how many)        

 (2)  Equipment (how much)  $       

 (3)  Space (number of square feet)        

 (4)  Funds (how much)  $       

 (5)  Clients (how many)        
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INFORMATION TECHNOLOGY  
POSITION QUESTIONNAIRE FORM 

 
f. Give at least two examples of your planning. 

 
  (1)        
 
  (2)        
 
Question 12. Does your position have decision-making authority?       Yes        No (Go to 14) 
 

If you answer yes, please complete the remainder of this question.  Give at least two examples of 
decisions you make independently without first checking with your supervisor.  
 
1.       
 
 
 
2.       

 
 
 Give at least two examples of decisions you make after checking with your supervisor: 
 
 1.       
 
 
 
 
 2.       
 

 
 
 
Question 13. If you have signature authority for your supervisor, list which documents you can sign. 
 
Documents: 
 
1.       
 
2.       
 
3.       
 
4.       
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INFORMATION TECHNOLOGY  
POSITION QUESTIONNAIRE FORM 

 
Question 14.   Do you represent your supervisor when he/she is absent?      Yes  No (Go to 16) 
 

If yes, what authority do you have? 
 

  Complete authority (includes fiscal authority over physical resources and personnel actions)   
  Limited authority (includes day-to-day activities or routine responsibilities, but no fiscal authority) 
  No authority 

 
Explain:  
 
      
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Question 15: To the best of your ability, fill in the organization chart.  Do not abbreviate class titles. 
 

• PUT YOUR CLASS TITLE IN THE BOX INDICATED. 
• PUT YOUR SUPERVISOR’S CLASS TITLE IN THE BOX ABOVE YOURS. 
• PUT THE CLASS TITLES OF OTHER PEOPLE WHO REPORT TO YOUR SUPERVISOR IN 

THE BOXES NEXT TO YOURS. 
• PUT THE CLASS TITLES OF PERSONS WHOSE WORK YOU DIRECT IN THE BOXES 

BELOW YOURS. 
• GIVE A BRIEF SUMMARY OF THE RESPONSIBILITIES OF THOSE EMPLOYEES WHOSE 

WORK YOU DIRECT. 
 

SOME EXAMPLES OF CLASS TITLES: Information Technology Consultant I, Computer 
Maintenance Technician II, Computer Support Analyst III. 
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Title of your Supervisor's Supervisor   

      
 

   

        
Title of your Supervisor   

      
 

   

          
Name and class 
titles of other 
positions reporting 
to your supervisor 

  
      

  
      
Your position class title 

  
      

  
      

 

          
Name and class 
titles of persons 
whose work you 
direct. 

 a. 
      

 b. 
      

 c. 
      

 d. 
      

 

          
BRIEF SUMMARY OF WORK PERFORMED BY PEOPLE YOU DIRECT 

 
a. 
      

b. c. d. 
                  

 
 
 
 

 
 
Question 16. Please provide any additional comments you feel are important to help determine the 

proper allocation of your position:  
 

 
Comments:        
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Your Signature: _____________________________  Date: __________________________ 

 
If your job contains lead or supervisory duties, complete Part II. 

If not, return the questionnaire to the Personnel Office 
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PART II 

APPLIES TO LEAD AND SUPERVISORY POSITIONS 

INSTRUCTIONS:  Complete this section if your position is responsible for any of the following: 
 

A. DIRECTING THE WORK OF OTHERS 
B. LEADING OTHERS 
C. SUPERVISING OTHERS 

 
Question 1.   Check the duties you perform:

  Assign work to others 
  Check work of others 
  Train employees to do their job 
  Schedule hours of other employees 
  Report progress/problems of other employees 
  Report hours of work of others 
  Establish goals for work unit 
  Plan work of others 
  Approve leave usage of other employees 
  Respond to grievances 
  Make hiring recommendations 
  Conduct annual and/or interim employee performances evaluations 
  Discipline employees 
  Make recommendations for dismissal 
  Develop performance expectations for other positions 
  Develop position descriptions for other positions 
  Resolve conflicts 
  Coach, counsel employees 
  Recommend layoff actions 
  Change employee assignments or shifts 

 
      B. How much time do you spend performing the above duties? (hours per month):       

 
Question 2. In the chart below indicate the number of people, by type, whose work you direct, and the 

hours they work each week. 
 

Kind of Employee(s) You 
Direct 

Number of Employee(s) You Direct Total Hours Employee(s) Work Each 
Week 

Classified             

Temporary or less than 1/2 
time 

            

Students             

Volunteers             

 Other:             

 TOTALS:             
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Question 3.  Complete the following:   
 

a. How many employees are there in your supervisor’s organization?  #      

b. What is the amount of your supervisor’s budget?  $       

c. What is the amount of your budget?  $       

d. If your organization serves clients, how many does it serve?   #       

e. How many employees report directly to you?  #       

f. How many supervisors report directly to you?  #       

 
Question 4.  Check the statements that apply to your position. 
 

      The person(s) whose work I direct: 

 Are in the same class as mine. 

 Are in a lower class. 

 Perform the same or similar work as I do. 

 Perform different work than I do. 

 Report directly to me. 

 Report directly to my supervisor, but I have charge of their day to day activities. 

 
Question 5. Please indicate at least two important decisions are you required to make concerning the 

following: (If you do not make decisions regarding an item, write "none" after the item.) 
 

a. Employees:        

b. Projects:       

c. Equipment/materials:        

d. Space:        

e. Funds:        

f. Others:        

 

 

 

Your Signature:______________________________________________Date:____________________ 
 
 
 
 
 

RETURN YOUR COMPLETED QUESTIONNAIRE TO THE PERSONNEL OFFICE 
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PART III 

MANAGEMENT AND PERSONNEL OFFICER STATEMENT 
 
SUPERVISOR  

TO BE COMPLETED BY THE EMPLOYEE'S IMMEDIATE SUPERVISOR 

 
INSTRUCTIONS: Please review this employee's position questionnaire.  Do not change any of the 
employee's responses.  Please make your comments below.  Be sure to answer all questions. 
 

STATEMENT  

General comments as to accuracy and completeness of statements of employee: 

 Response:       

 

 

 
 

 
 
Question 1. The employee’s statements are accurate and complete except:  (please be specific) 
 

 
Response:       
 
 
 
 
 
 
 

 
(Note:  Please attach a separate page if you need more space.) 
 
Question 2.  Which class specification do you believe best describes the employee's position as a whole?           
 
 
        
 
 

 
Why?       
 
 
 
 
 

 
a. How long has the employee been performing these duties?       
b. Did you assign these duties in writing?    Yes      No  If yes, when?       

(Please attach a copy of any written correspondence regarding the addition of 
duties.) 
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Question 3.  What level of supervision do you exercise over this position? 
 

 
Response:       
 
 

 
 
Question 4.  Please give examples of decision-making authority you have delegated to this position.  
 

 
Examples:        
 

 
SUPERVISOR:   
 

• Discuss the above comments with the employee and provide a copy of this 
section if requested. 

 
• If possible, attach the organization chart for your department to this 

document. 
Supervisor’s Name:          

Supervisor’s Position Title:        

Telephone Number:         

E-mail Address:         

Date:          

Signature of Supervisor:  ____________________________ 

 

DEPARTMENT HEAD OR SECOND-LEVEL SUPERVISOR: 
 

TO BE COMPLETED BY THE SECOND-LEVEL SUPERVISOR OR DEPARTMENT HEAD 

 
INSTRUCTIONS: Please review this employee's position questionnaire and comments of the immediate 
supervisor.  Do not change any of the employee's responses.  Please make your comments below.  
 

STATEMENT  

Please provide your comments as to accuracy and completeness of statements of employee and 
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immediate supervisor. 

Comments:        

 

 

 

 

 

 

 

 

 

 

 

 
 

Signature of Department Head or Authorized Representative: _______________________________ 

Date:       

Position Title:        

Phone Number:        
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PERSONNEL OFFICER 
TO BE COMPLETED BY THE INSTITUTION’S PERSONNEL OFFICER 

Position audit completed on (Date):        (Phone Number)       
 
Position audit conducted by:  (Name)        (E-mail)           
   

  
Results of Audit: 
 

Position was Reallocated From:          To:        
 
Effective Date of Reallocation:       
 
Position Was Not Reallocated:  
 

List of Classes Considered:       
 
          
 
           
 
Rationale for Decision:  
 
      
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Personnel Officer:               _______________________________________ 

            Signature 
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